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0.0 Start BOOL
0.1 Stop BOOL
2.0 Motor_on BOOL
4.0 Speed INT

DB 5

FB 5

in Start BOOL
in Stop BOOL
out Motor_On BOOL
out Speed INT
stat ...
Temp...

...
A #Start
AN #Stop
= #Motor_on
...

드라이브

Function FC10

in On_1 BOOL
in On_2 BOOL
out Off BOOL
...

...
A #On_1
A #On_2
= #Off
...

CALL  FB5, DB5
Start :=I 0.0
Stop :=I 0.1
Motor_on :=Q8.0
Speed :=QW12

프로그램실행

CALL  FC 10
On_1 := I 0.1
On_2 := I 0.2
Off := Q8.0
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교육목표

... 파라미터를지정하는블록을이해합니다.

... 파라미터를지정하는 FC 를생성하고호출합니다.

... FC 와 FB 차이를이해합니다

... Static 변수사용을이해합니다.

... Static 변수를선언하고프로그램에적용합니다.

... 파라미터를지정할수있는 FB 를생성하고호출합니다.
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변수종류

Temporary변수
•해당블록실행후값들이오버
라이트됩니다.

• L스택에저장됩니다

• OB/FC/FB 에서사용가능

Static변수
•해당블록실행후에도
값들이유지됩니다.

• DB에데이터저장

• FB에서만사용가능

로컬변수 / 데이터
(하나의블록에서만사용가능)

글로발변수 / 데이터
(전체프로그램에서사용가능)

• PII / PIQ

• I / O Peripherals

• M / T / C

• DB areas

심벌절대

엑세스

개요 지금까지프로그램에서는입력과출력이실제어드레스로직접할당이된채작성되
었습니다. 이러한유형의프로그램은어드레스위치에고정이되기때문에반복적인
프로세스에는잘맞지않습니다. 파라미터를지정하지않는블록들은반복적인프로
세스가없는기계제작에적합합니다. 
대형시스템에서반복적인프로세스는재사용할수있고파라미터를설정할수있는
블록들(Function 과 Function Block) 을사용하는것이효과적입니다. 이러한블록들
은심벌입력과출력파라미터(로컬심벌이름)를사용하며블록이호출될때실제피
연산자와함께사용됩니다. 
사용자는이러한피연산자를 Function 이나 Function Block 을호출할때할당해야
합니다. FC/FB 의프로그램로직은변경되지않기때문에여러번재사용할수있습
니다. 

로컬변수 지금까지는생산데이터등을저장하기위해 글로벌변수 (비트메모리와데이터블
록)를사용했습니다. 이단원에서는로컬변수라는데이터저장장소를접하게됩니
다. 
로컬변수는그것들이생성된블록에서만읽을수있으며이로인해다른프로그램
블록들의로컬변수와는데이타교환을할수없습니다.
두가지유형의로컬변수가있습니다. - Temporary 와 Static
Temporary 변수 : 
Temporary 변수는블록이실행되는동안에만저장되는변수입니다. 모든프로그램
블록(OB, FB, FC)에서선언될수있습니다. 
Static 변수 : 
데이터가블록이수행이된이후에도유지가되어야한다면데이터는 Static 변수에
저장이되어야합니다. 
Static 변수는 Function Block 에서만선언이됩니다. FB에할당된인스턴스 DB 가이
러한 Static 변수를저장하는장소로사용이됩니다.
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개요 Temporary 변수는모든프로그램블록에서사용될수있습니다. 이변수는블록이
수행되는동안정보를임시로저장하기위해사용됩니다. 데이터는블록프로그램을
마치고나면잃어버리게됩니다. 
데이터는 L 스택 (로컬데이타스택) 에저장됩니다. 이것은 CPU 내별도의메모리
영역입니다.

선언부 블록의선언테이블에서변수들을선언합니다. "TEMP" 행에서변수이름과관련
데이타타입을입력합니다. 여기서는초기값(Initial Value)을미리선언할수
없습니다. 
블록을저장한후에 L 스택의메모리위치가 "Address" 컬럼에디스플레이됩니다. 

엑세스 네트워크(렁) 1 에서 Temporary 변수에대해심벌로엑세스를하는예를볼수있
습니다. 빼기의결과가 Temporary 변수 "Result" 에저장됩니다. 사용자는절대어
드레스를입력할수있습니다(T LW0). 그러나프로그램이읽기가더어렵기때문에
절대어드레스를피하는것이좋습니다. 

참조 # 문자로시작하는변수는로컬변수이며선언테이블에서정의된블록에서만사
용할수있습니다. 프로그램편집기가자동적으로 # 글자를입력시켜줍니다. 

Date: 22.03.2006
File: PRO1_12E.4

SIMATIC S7
Siemens AG 2004. All rights reserved.

SITRAIN Training for
Automation and Drives

Temporary변수

Declaration

Use
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전체사용량 모든프로그램실행이나혹은우선권등급 (예를들면 OB1과그안에서호출된모
든블록)을위해별도의 L 스택이예비되어있습니다.(CPU 의 L 스택에할당된세
그먼트크기) 즉, OB1에의해호출된블록들가운데사용된로컬변수나
Temporary 변수 뿐아니라 OB1 의로컬변수가 L 스택에저장이됩니다. 레퍼런
스데이터기능을사용하여 S7 프로그램이 L 스택에얼마나많은부하를주고있
는지를볼수있습니다. 레퍼런스데이타는 "고장탐구 (Troubleshooting)" 단원에
서더자세히다룹니다. 

레퍼런스데이타 SIMATIC Manager에서블록폴더를선택하고다음메뉴를선택합니다.
Options -> Reference Data -> Display -> Program Structure

참조 프로그램실행중에최대로컬데이터가초과가되면(L 스택오버플로우) CPU 가
STOP 이됩니다. 진단버퍼(Diagnostic buffer) 에는 "STOP caused by error 

when allocating local data" 가에러의원인으로입력이됩니다.
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로컬데이터스택전체사용량
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설명 발생한문제는오퍼레이터콘솔에있는 LED 에디스플레이가됩니다. 문제가발생하
면 (I 0.0), LED (Q 5.1)  이 2 Hz 로깜박거리게됩니다. 
문제는입력 I1.2 에서인식이됩니다. 문제가수정이되면 LED 는깜박거리지않게
됩니다. 문제가계속되면 LED 는문제가해결될때까지 켜진상태로멈추게됩니다. 

문제 오류신호의 RLO 에지에대한검출이이루어지게됩니다. 이는존재하는문제가인
식이되면메모리가즉시리셋이되기때문입니다. 
메모리가세트가되면 (메시지는아직인식이되지않았습니다) 상부의 AND 명령어
로인해 LED가깜박거리게됩니다. 이로인해하드웨어설정에서클럭메모리
(Clock Memory) 로정의된비트메모리 M 10.3 이 동작을하게됩니다. 
하부 AND 명령어로인해인식은되었지만아직존재하는문제가있을때 LED 가켜
진상태로멈추게됩니다.
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예 :출력 LED 로오류신호디스플레이

폴트신호

디스플레이

인식

저장된폴트

솔루션제안

작업
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어플리케이션 자주반복되는프로그램에는파라미터지정블록을사용할수있습니다. 
-프로그램이한번만생성이되면되기때문에프로그래밍시간을크게줄일수 있
습니다.
-블록이사용자메모리에한번만저장이되면되기때문에전체메모리양을크
게줄일수있습니다.
-블록은사용자가원하면언제든호출될수있으며각각다른어드레스가할당이 됩
니다. 이를위해형식파라미터 (Formal Parameter )에는블록이호출될때 마다다
른실제어드레스 (Actual address)가할당이됩니다. 

프로그램실행 위예제에서 STL 언어를볼수있으며프로그램실행을따라가기가더쉽습니다. 
STL 코드는이전예제와같은오류로직을수행합니다. STL 프로그래밍언어는고급
과정에서더자세히다루어질예정입니다. 
위에서보는블록이실행이되고 A #Acknowledge" 가수행이되면 Acknowledge 파
라미터가실제파라미터로바뀌어지게됩니다. 입력 I 1.1 이 Acknowledge 파라미터
의실제파라미터로주어지게되면 FC 20 프로그램블록에서보는 "A   
#Acknowledge" 대신에 A I 1.1 이들어가게됩니다. 

파라미터설정 FC 나 FB 블록을파라미터지정블록으로프로그램할수있습니다. OB 블록은운영
시스템에서직접호출이되기때문에파라미터를지정할수있는프로그램을생성
할수없습니다. 사용자프로그램에서는 OB 블록호출이이루어질수없기때문에
실제어드레스를 OB 로전달하는것이불가능합니다. 

예 시스템에서서브루틴이두번필요하다고해도파라미터지정블록의 FC20 은한번
만프로그램하면됩니다. FC 20 은두개의서로다른오류에대해호출할수있고매
번다른실제어드레스를할당하게됩니다.
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파라미터지정가능블록

A I 1.1

FP M 17.2

S M 17.1

A I 1.0

R M 17.1

A M 17.1

A M 10.3

O

AN M 17.1

A I 1.1

= Q 5.1

파라미터를지정
할수없는블록
사용 FC 20 호출 (OB 1에서호출)

Fault_
Signal

Stored_
Fault

Acknowledge

Edge_
Memory

Display

Flash_Freq.

FC 20

형식파라미터

A #Fault_Signal

FP #Edge_Memory

S #Stored_Fault

A #Acknowledge

R #Stored_Fault

A #Stored_Fault

A #Flash_Freq.

O

AN #Stored_Fault

A #Fault_Signal

= #Display

파라미터를지정할수있는블록사용

FC 20 에서의프로그램

M 17.1

M 17.2

I 1.1

I 1.0

M 10.3

실제파라미터

Q 5.1
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FC 20 에서의형식파라미터정의

사용 그래픽디스플레이

읽기만해당 블록의왼쪽

쓰기만해당 블록의오른쪽

파라미터타입

입력파라미터

출력파라미터

입/출력파라미터

선언

in
out
In_out 읽기 / 쓰기 블록왼쪽

형식파라미터

Formal Parameter 파라미터지정블록프로그램을생성하기전에먼저선언부테이블에서형식파라미
터(Formal Parameter)를정의해야합니다. 

파라미터유형 슬라이드의테이블에서세개의다른파라미터타입이블록에사용되고있는것을
볼수있습니다. 사용자는원하는대로형식파라미터에대한유형선언을할수있습
니다. "in" 선언유형은서브루틴에서 "읽기" 선언유형이지정되어야합니다. "out" 선
언유형은서브루틴에서 "쓰기" 선언유형이지정되어야합니다. 읽기엑세스(A,O,L 
명령어사용)를위한형식파라미터과동시에쓰기엑세스 (S,R,T) 를위한형식파라
미터는 "in/out" 파라미터에선언이되어야합니다. 

인터페이스 블록의인터페이스는 IN, OUT, IN_OUT 파라미터를갖습니다. RETURN 파라미터
는 IEC 61131-3 에따라특정하게지정된 부가적인 OUT 파라미터입니다. 이파라미
터는 FC 에서만존재합니다.
TEMP 변수는블록이호출이될때눈에보이지않으며실제어드레스가호출되는
블록의 TEMP 변수에전달되는것이아니기때문에블록인터페이스의요소가될
수없습니다. 
파라미터와 TEMP 변수를선언하려면파라미터유형이나 TEMP 변수유형이
"interface" (아래쪽그림참조) 에서선택되어야합니다. 그후오른쪽에나타나는테
이블에서이름이관련데이터유형과주석과함께편집될수있습니다.

FC 20 의예 슬라이드의아래쪽부분에서 FC 블록 "Fault Signal" (이전페이지참조) 의인터페이
스와선언테이블을볼수있습니다. 형식파라미터 #Stored_Fault 와
#Edge_Memory 가 FP 명령어에연결되어읽기와쓰기명령어로사용이되기때문
에이러한것을 in/out  파라미터에선언을해야합니다. 

주의! 선언된블록의형식파라미터 (IN, OUT, IN_OUT, TEMP는예외) 는 "outside" 로의
인터페이스입니다. 즉그것들은눈에보이고다른블록과연관이있기때문에그렇
게부릅니다. 블록인터페이스가추후형식파라미터를삭제하거나추가를한다면
호출하는것도업데이트되어야합니다. 이블록을호출하는모든블록도업데이트되
어야합니다. 
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파라미터지정가능블록편집

참조 형식파라미터이름이소문자로쓰여졌든지대문자로쓰여졌든지상관이없습니다. 
# 글자가이름앞에자동적으로삽입이됩니다. 이글자는파라미터가이블록의변
수테이블에서정의된로컬변수임을가리키는데사용이됩니다. 
프로그램을 LAD/FBD 에서작성을할때이름이하나의라인에모두나오지않게하
는것이가능합니다. 이는프로그램편집기에서필요에맞게설정하면됩니다. 
(Options -> Customize -> LAD/FBD 탭 -> Address Field Width)

심벌 1. 블록을편집할때심벌이름을사용한다면편집기는가장먼저블록의변수선 언
테이블을통해그이름을찾습니다. 
심벌이름이있다면심벌과이름앞에있는 # 문자가로컬변수로수용이됩니 다. 

소문자와대문자는심벌이선언테이블에서입력된것에맞게수정될것입니다.
2. 심벌을로컬변수에서찾을수없다면편집기는글로벌심벌테이블에서심벌 을
찾습니다. 
심벌이거기있다면심벌은인용부호표시로놓여지게되고프로그램에서글 로

벌변수로수용이됩니다. 
3.. 심벌테이블과로컬선언테이블에서같은심벌이름이지정이되면편집기는 언
제나로컬변수를채택합니다.
그러나글로발심벌로작업을하기원하면입력시심벌이름을인용부호표시 에

넣습니다.
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파라미터지정가능블록호출

블록호출프로그래밍 파라미터를지정하는블록의호출은원하는블록의심벌을복사해서호출하는블록
의프로그램입력부분에입력할수있습니다. 드래그앤드롭을사용하면편리합니
다. 이심벌은프로그램편집기의 "Program Element Catalog" 부분의 "FC Blocks" 혹
은 "FB Blocks" 부분에서찾을수있습니다. 인용부호영역은호출된블록의각형식
파라미터에자동적으로나타납니다. 

참조 파라미터를지정하는 FC 가호출이되면실제어드레스는모든형식파라미터로전
송이됩니다. 
예외 : 
LAD 와 FBD 와같은그래픽프로그램언어에서 EN과 ENO 파라미터는편집기에
의해자동적으로추가가됩니다.여기에는형식파라미터를지정하지않으며이파
라미터들을통해조건적으로블록을호출할수있게할수는있습니다. 

파라미터설정 입력하는데이타타입이호출된블록의형식파라미터에맞으면글로발어드레스혹
은로컬어드레스가실제파라미터(어드레스)로전달됩니다. 
실제파라미터는절대어드레스나전역심벌테이블에서정의한심벌이름혹은호
출하는블록에서의선언테이블에서정의한심벌이름으로전달됩니다. 

파라미터전달 기본적으로 "파라미터전송 (Passing on of parameters)"이가능합니다. 즉호출하는
블록의형식파라미터가호출된블록의실제파라미터로전달이되는것입니다.  복
합데이터타입의파리미터인경우한계가있긴하지만가능합니다. 이내용은고급
과정에서다루어질것입니다.
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오류해석 Function 오류가발생을하면 (시뮬레이터의스위치동작) 시뮬레이터의출력 LED가 2 Hz 로
깜박거리기시작합니다. 사용자는시뮬레이터의푸시버튼을사용하여오류를인식
할수있습니다. 

오류가인식이되면두가지중하나의경우일것입니다. 오류가더이상존재하지않
다면(시뮬레이터의스위가꺼짐) 출력 LED 도꺼지게될것입니다. 오류가계속존
재한다면 (시뮬레이터의스위치가계속켜짐) 출력 LED는켜진상태에서멈출것입
니다. 오류가더이상존재하지않으면 LED 는꺼지게됩니다.

과제 오류해석프로그램을파라미터지정 FC 20 "Evaluate_Fault" 안에생성하십시오.

절차 1. FC 20 블록을 S7 블록폴더에삽입하십시오.
2. 위슬라이드에보여진것처럼형식파라미터를선언하십시오.
3. 위슬라이드에보여진것처럼프로그램을생성하십시오.
4. 블록을저장하고 CPU로다운로드하십시오.
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연습문제 1 :파라미터지정가능 Function 편집

Declaring the Formal Parameter
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과제 두개의프로세스에러 (시뮬레이터의두개의스위치)가해석이되고시뮬레이터의
LED 를통해디스플레이됩니다. FC 20 을두번호출하는프로그램을작성하고위
슬라이드에보여진것처럼실제파라미터를입력합니다.

절차 1. FC 20 을프로그램하십시오 - FC 17 블록에두개의새로운네트워크(렁)에서 호
출하십시오.
2. FC 17 을저장하고 CPU 로다운로드하십시오.

참조 HWConfig 화면에서클럭메모리 (Clock Memery) 로 MB 10을설정하였습니다. 메모
리리셋을수행한다면 M10.3 비트메모리가깜박거리게하기위해서는 HWConfig 
에서생성된시스템데이터(system data) 를다시다운로드시켜야합니다.
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연습문제 2 :파라미터지정가능 Function 호출

FC 20 의첫번째호출

FC 20 의두번째호출
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FB의특징 FC 와는다르게 FB 에는 Recall 메모리가있습니다. 이는로컬데이타블록이
Function Block 에할당이되는것을의미합니다. 이데이타블록을인스턴스데이터
블록(Instance DB)이라고합니다. FB 를호출할때인스턴스 DB 의번호도지정해야
합니다. 인스턴스 DB는 Static 변수를저장하기위해사용됩니다. 이러한로컬변수
는 FB의선언부에서선언을하여사용될수있습니다. 프로그램이종료가되어블록
을빠져나와도데이터는남아있습니다 .

Exclusion 어드레스와 Termination 어드레스
이옵션을사용하면속성을프로세스진단과연관되어있는 FB 파라미터와 Static 변
수에할당할수있습니다. 

파라미터 Function Block 이호출되면실제파라미터의값들은인스턴스 DB에저장이됩니다. 
실제파라미터가블록호출에서형식파라미터에할당이되면이파라미터에대해
인스턴스 DB에저장된최종값이프로그램실행시사용이됩니다. 사용자는모든 FB 
호출시다른실제파라미터를지정할수있습니다. 
Function Block 을빠져나와도인스턴스 DB 에는데이터가남아있습니다. 

Static 변수 Static 로컬변수는 Function Block 에서엑세스할수없는특정데이터를저장합니다. 
다시말해서변수는형식파라미터로서다른블록에입력되거나출력되지못한다는
뜻입니다. 

FB 장점 - FC에서프로그램을할때는사용하지않은비트메모리어드레스영역과데이 터
영역을찾아야만합니다. FB에서의 Static 변수는 STEP 7 소프트웨어에서 관리를
해줍니다. 
- Static 변수를사용하면비트메모리영역이나데이터영역을두번지정하는일 을
피할수있습니다. 
-형식파라미터 FC 20의 "Store Fault" 와 "Edge_Memory" 대신에 Static 변수

"Stored_Fault" 와 "Edge_Memory" 를사용할수있습니다. 이는두개의형식 파
라미터를삭제시킬수있기때문에블록호출이더간단해집니다. 
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Function Blocks (FB)

FB 20
EN

Fault_Signal

Acknowledge Display

Flash_Freq. ENO

DB 2

Function Block의
선언부

OB1 에서처럼 FB 블록호출
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오류디스플레이 이전의연습문제에서오류메시지를디스플레이하기위한파라미터지정블록 FC 
20 을생성하였습니다. 
비트메모리대신에오류신호와 RLD 에지검출을저장하기위해 FC 20 을사용하
였고 FB 에서는이것이 Static 변수라고합니다. 그것은 FB 와연관된인스턴스 DB 
에저장이되었습니다. 

인스턴스 DB 구조 DB가생성이되고 FB 에연결이될때 STEP 7 은 Function Block 의로컬선언테이
블에서지정된구조를사용하여데이터블록의데이터구조를생성합니다. DB 를저
장한후에 DB가생성이되고인스턴스 DB 로사용할수있습니다.
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오류디스플레이를위한 Function Block

Function Block의
선언부

인스턴스데이터
블록
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인스턴스 DB 생성 새로운인스턴스 DB를생성하는데는두가지방법이있습니다. 
- FB 를호출할때어느인스턴스 DB 를 FB에사용할것인지지정해야합니다. 다
음과같은메시지가나타납니다.

"The instance data block DBx does not exist. Do you want to generate it ?„

-새로운 DB를생성할때 "Data block referencing a function block" 옵션을선택합니
다.

참조 하나의인스턴스 DB가하나의 FB 에연결됩니다. 그러나 FB 는호출될때마다다른
여러인스턴스 DB 에연결될수있습니다. 
FB 를파라미터나 Static 변수를추가하여변경할때는인스턴스 DB를다시생성해
주어야만합니다.
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인스턴스데이터블록생성

1. FB호출시인스턴스데이터블록생성 2. 별도로인스턴스데이터블록생성

In the LAD/STL/FBD Editor In the SIMATIC Manager



SITRAIN Training for
Automation and Drives

ST-PRO1
Function과 Function Block페이지 16

Date: 22.03.2006
File: PRO1_12E.16

SIMATIC S7
Siemens AG 2004. All rights reserved.

SITRAIN Training for
Automation and Drives

연습문제 3 : Function Block 편집

과제 추가오류(시뮬레이터스위치)가해석되어야합니다. 이것을하기에가장쉬운방법
은 FC 20 호출을또한번하는것입니다. 
그러나 FB 솔루션의장점을살리기위해파라미터지정 FB 20 을프로그램하여세번
째오류를해석합니다. 
Static 변수는 Edge Memory 와 Stored Fault 를저장하는데사용됩니다. 이러한
Static 변수는 FB 의인스턴스 DB에저장될것입니다. 
위슬라이드에서 FB 20의선언테이블입력과출력파라미터와프로그램시작을볼
수있습니다. 

절차 1. FB 20 블록을 S7 블록폴더에삽입하십시오.
2. 위슬라이드에나온것처럼형식파라미터와 Static 변수를선언하십시오.
3. FB 20 의프로그램을작성하십시오. 이미생성된 FC 20 에서필요한네트워크(렁
)을복사해서 FB 20 에붙여넣기를하십시오.
4. 새로운블록을저장하고 CPU 로다운로드하십시오.
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과제 오류 #2의해석 (지금까지 FC 20 에서프로그램을하였음) 과새로운오류 #3 의해
석이새롭게생성된 FB 20 으로구현이될것입니다.
파라미터지정블록 FB 20 이 FC 17 에서두번호출이되어야합니다. 
FB 20 이호출될때마다다른인스턴스 DB 가할당되어야합니다. 

절차 1. FC 17 에서두번째호출된 FC 20 을삭제하십시오. 오류 #2가 FB 20 에서 구현
되기때문입니다. 
2. 슬라이드와같이 FC 17 에서두개의새로운렁에 FB 20 이두번호출됩니다. 편
집기에서인스턴스 DB2 와 DB3 을생성하십시오.
3. 변경된 FC 17을오프라인에서저장하십시오.
4. 생성된 DB2 와 DB3 을 SIMATIC Manager 에서 CPU 로다운로드하십시오. 이 후
변경된 FC 17 을다운로드하십시오.
5. 사용자프로그램을테스트하십시오.

과제 2 오류해석에대한 Function Block 을성공적으로테스트한후에다음프로세스신호
를시뮬레이터스위치대신에오류신호로사용할수있습니다.

-비트메모리신호 M 17.0 "Conveyor belt fault condition"
-근접스위치 1번베이와 2번베이를자동모드로동시에동작을시키십시오. 두 번
째작업은다음연습문제로이어지지않습니다. 
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연습문제 4 : Function Block 호출및테스트

현재상태 현습문제실행후상태
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블록파라미터삽입과삭제

Sa
ve

문제 프로그램생성중에혹은프로그램실행중에각블록의선언부나프로그램을추후
에조정하거나추가하려고할때 "Time Stamp Conflict" 가발생합니다. Time Stamp 
Conflicts 는호출블록과호출된블록이나관련 블록사이의내용이서로같지않은
문제를차례로발생시킬수있기때문에많은수정작업이필요해집니다.

블록파라미터가추후에프로그램에서이미호출된블록에서추가되거나삭제될때
다른블록에서의블록호출도업데이트되어야만합니다. 이것이무시되면 CPU는
STOP 으로전환됩니다. 혹은추가적으로선언된형식파라미터가호출될때실제
파라미터에적용되지않기때문에블록의기능은더이상보증할수없게됩니다. 
예제에서추가적인입력파라미터 "Check_Light" 가삽입이되었고나중에모든블록
호출시실제파라미터가할당이됩니다. 
형식파라미터가추가되거나삭제된블록을저장할때일어날수있는경고메시지
가나타납니다.
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블록 Consistency 체크

블록 inconsistency

사용영역 Check block consistency -> Compile 기능은모든 Time stamp conflict 를제거하고
블록불일치를체크합니다. 
인터페이스충돌은파라미터지정블록이생성이되고다른블록에서호출이된이
후추가적으로수정이될때발생합니다. 블록불일치는또한어드레스가심벌로엑
세스되고그후글로발심벌테이블이나데이타블록에서심벌 <-> 절대어드레스가
변경되었을때발생합니다. 
슬라이드에서는일부블록들에불일치가생기고 (예 : 인터페이스충돌) 이것을가리
키는심벌이나타나있습니다. (온라인도움말참조) 이러한블록들은오픈이될수
있고오른쪽마우스버튼을사용하여교정이될수있습니다. (다음페이지참조)

트리구조보기 트리구조보기는선택된블록폴더에있는블록들의연관성을보여줍니다. 트리구
조보기는 View -> Reference Treee / Dependency Tree 를통해 Depency Tree 나혹
은 Referece Treee 로표시될수있습니다. 

Reference Tree (레퍼런스트리)
레퍼런스트리는왼쪽에서오른쪽으로모든블록과호출관계를레벨별로보여줍
니다. Reference Data Program Structure 처럼호출관계가왼쪽에서오른쪽으로처
음호출레벨 1번부터보여줍니다. 그러므로레퍼런스트리는각프로그램실행레
벨의호출에대해전체보기를제공해줍니다. 

Dependency Tree (디펜던시트리)
디펜던시트리는왼쪽에서오른쪽으로모든블록과호출관계를레벨별로보여줍니
다. 이경우보여지는호출관계는호출레벨 1번부터는아니고개별적인블록에서
부터보여줍니다. 따라서블록폴더에있는모든블록은왼쪽레벨에모두리스트됩
니다. 다음레벨 (오른쪽으로)은호출되는블록들혹은의존성을보여줍니다. 
Reference Data -Cross reference list 와같이디펜던시트리는어느블록을호출하
였는가에대한정보를제공합니다 .
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수정된블록호출

Once with the right

호출업데이트 일치하지않는블록호출은호출한블록에서적색으로표시됩니다. 일치하지않
는호출을오른쪽마우스로클릭하고나타나는다이알로그박스에서 Update Block 
Call 을선택하십시오. 이전블록(오류가있는블록)과새로운블록(슬라이드에서
"Check_Lights" 의파라미터가추가됨) 호출을보여주는윈도우가나타납니다. "OK" 
로확인을한후빠져있는 "Check_Lights" 형식파라미터에실제파라미터를입력합
니다. 
인스턴스 DB가 Function Block 에대해다시생성이됩니다.
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0.0 Start BOOL
0.1 Stop BOOL
2.0 Motor_on BOOL
4.0 Speed INT

DB 5

Function과 Function Block 의비교

FB 5

in Start BOOL
in Stop BOOL
out Motor_on BOOL
out Speed INT
stat ...
Temp...

...
A #Start
AN #Stop
= #Motor_on
...

드라이브

Function FC10

in On_1 BOOL
in On_2 BOOL
out Off BOOL
...

...
A #On_1
A #On_2
= #Off
...

CALL  FB5, DB5
Start :=I 0.0
Stop :=I 0.1
Motor_on :=Q8.0
Speed :=QW12

프로그램 실행

CALL  FC 10
On_1 := I 0.1
On_2 := I 0.2
Off := Q8.0

Functions Fuctions 은메모리가없는파라미터지정블록입니다. STEP 7 에서 Function 은필
요한대로입력, 출력,입/출력파라미터를가질수있습니다. 
Functions는자체적으로결과를저장하는데이터영역을가지고있지않기때문에
메모리가없습니다. Function 을실행하면서발생하는중간결과는로컬데이터스
택의 Temporary 변수에저장이되면됩니다. 
Function 은기존의방법대로프로세서의명령어군을확장합니다. 

사용영역 Functions 는블록을호출하면서 Function 값이다시돌아올때주로사용합니다. (수
학적 Function 이나이진로직이있는개별제어와같은 Function)

Function Blocks Function Blocks (FB) 은사용자프로그램블록이며 IEC 61131-3 을따르고있는메
모리가있는로직블록입니다. OB, FB,FC 에서호출될수있습니다. Function Blocks 
는필요한대로 Static 변수, Temporary 변수를비롯입력, 출력, 입출력변수를가질
수있습니다. 
FC 와는다르게 FB는메모리가있습니다. 즉, 하나의 FB는자체데이터영역을가지
고있습니다. 그래서프로세스상태를하나의호출에서다음호출까지기억할수있
습니다. 가장단순한형태로이자체데이터영역이 DB 안에있게되며이 DB를 인
스턴스 DB 라고부릅니다. 

"Memory“ Function Blocks 의선언테이블에서사용자는 Static 변수를선언하고처음호출에서
다음호출까지이정보를기억합니다.
이것이 Function과주로다른점입니다. 
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연습문제 5 :변수타입인식

Absolute Symbolic Static ParameterGlobal Local
L #Number_1

T #Maximum_value

T MW 40

Statement

L #Number_2

L "Number_1"

T #Number_2
T MW 40

과제 슬라이드의명령문영역에서여러변수들을볼수있습니다. 아래테이블에서는해
당속성을변수에할당시킵니다. 

절차 테이블에서관련데이터유형을 X 자로표시하십시오.

다음질문에답하십시오.
명령문 T #Number_2 에서무엇이틀렸습니까?

.......................................................................................................................

.......................................................................................................................

.......................................................................................................................
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표준 FC 표준 FC 를실행할때다음과같은규칙이있습니다.
- EN =0 이면블록은실행을하지않으며 ENO = 0 입니다.
- EN =1 이면블록은실행을하며에러없이실행이되면 ENO 도 1 입니다.
블록이실행되는동안에러가발생하면 ENO 는 0가됩니다. 

사용자 FC 사용자블록이 LAD/FBD 로작성이되었는지 STL 로작성이되었는지는문제가되
지않습니다. LAD/FBD 에서호출이될때는 EN과 ENO 가추가가됩니다. 
EN/ENO는 STL 프로그램에서는존재하지않습니다.그러나에뮬레이션을할수는
있습니다. 
프로그램언어와상관없이에러처리에 프로그램은작성되어야합니다. 

내부연결 LAD/FBD 에서여러개의박스가그룹이지어질수있으며 EN/ENO 를통해논리적
으로링크될수있습니다.
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LAD/FBD STL

EN/ENO사용

CALL FC 1            
NOP  0

FC 1

EN ENO...무조건적인호출

A I 0.1                
JNB _001    
CALL FC 1      

_001: A             BR              
= Q 5.0

FC 1
EN ENOI 0.1 =

Q5.0

조건적인호출

예

...

ADD_I

EN ENO

MUL_I

EN ENO

DIV_I

EN ENO =

Q 5.1
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CALL CALL  명령은프로그램을호출할때사용합니다. 그래픽프로그래밍언어인 LAD 와
FBD 에서블록호출은 CALL 박스의 EN 입력을사용하여 RLO 의조건에따라실행
되도록이루어질수있습니다. STL 프로그래밍언어에서블록호출은 RLO 와상관
없이이루어집니다. 
FB 혹은 SFB 를 CALL 명령어로호출하면연관되는인스턴스 DB를지정해야만합
니다. 이블록을절대이름이나심벌이름으로사용할수있습니다. 
예: "CALL FB2, DB2" 혹은 "CALL valve, level„

UC "UC" 명령은 FC,FB 블록을무조건적으로호출하는것입니다. UC 는호출된 FC 나
FB가파라미터지정블록이아닌경우에만사용됩니다. 
또한 UC 로호출되는 FB에서는 Static 변수가선언될수없습니다. 

CC "CC" 명령은 FC 혹은 FB 블록을조건적으로호출할때사용됩니다. CC는호출된
FC 혹은 FB 가파라미터지정블록이아닌경우에만호출됩니다. 또한 CC 로호출되
는 FB 에서는 Static 변수가선언될수없습니다. 

절차 UC 와 CC 명령은래더와 FBD 로변환되지않습니다. 또한프로그램편집기에서파
라미터지정블록에서 UC 나 CC 호출을허용합니다. 그러나이프로그램이다운로
드가되면 "AREA ERROR when Reading" 이라는시스템오류가발생합니다. 

파라미터 블록의선언테이블에서선언된형식파라미터는블록의인터페이스입니다. 파라미
터지정 FC 가호출되면실제파라미터는반드시모든형식파라미터에할당되어야
합니다. FB가호출이될때는이러한파라미터는반드시입력이되어야하는것은아
닙니다. 
Static 변수와 Temporary 변수는파라미터가아닙니다. 그리고블록인터페이스의
일부분이아닙니다. 그결과블록호출에서 Static 이나 Temporary  변수로입력되어
야하는파라미터는없습니다.
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정리 :블록호출

• CALL  FC1
• UC  FC1
• CC  FC1

STL

LAD

FBD
FC1

EN

ENO

FC1
EN ENO

FC1    

( CALL )

FB

적용되지않음

파라미터, Static 없는경우

적용되지않음

• UC  FB1
• CC  FB1

CALL

파라미터가있는경우

• CALL  FC2
Par1: ...
Par2: ...
Par3: ...

FC2
EN ENO

Par3

Par1

Par2

FC2
EN

ENO

Par1

Par2

Par3

파라미터, Static 있는경우

• CALL  FB2, DB3
Par1: ...
Par2: ...
Par3: ...

FB2
EN ENO

Par3

Par1

Par2

DB3

FB2
EN

ENO

Par3

Par1

Par2

DB3

파라미터가없는경우
언어

FC

FC1    


